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Let’s get started! 

 

How to turn your computer on and log in 

1. Plug your computer in to a power source 

2. Connect your mouse 

3. Press the power button (see image) 

4. Enter a username and password (the 

class laptops do not require a password 

so just click “Sign In”) 

 

 

 

 

 

 

 

 

How to use your mouse 
 

Mouse Action What the action does 

Click 

(Press the left mouse button once) 

Moves the mouse pointer to that location on 

the page. 

Double-click 

(Click the left mouse button twice 

in a QUICK sequence.) 

Opens a program, file or document. 

Drag and drop 

(Hold down the left mouse button 

while moving the mouse) 

Moves items. 

Right-click 

(Click the right mouse button 

once) 

Gives you a menu of options. 
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Finding programs  

(e.g. Word, Excel, Google Chrome) 

The Task Bar 

At the bottom of your screen are 

icons for the programs you most 

commonly use (e.g. Word, Excel, 

Google, Publisher, PowerPoint, File 

Explorer). This strip of icons is 

called the “Task Bar”.  

You can add programs you 

commonly use to the Task Bar and 

remove them. 

 

Windows icon 

At the bottom left of your page is 

an icon that looks like a window. 

This is called the Windows icon or 

Start button (see image). 

You can find every program (even 

the ones you don’t commonly 

use) on your computer by clicking 

this Start button. 

 

Opening a program 

Left click on an icon to open the 

program. 
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Minimise, maximise/restore and close a program 

If you open a program you will see three buttons in the top right corner. One is the 

‘Minimise’ and the other is called the ‘Maximise or Restore’ button and then the ‘X’ is 

the Close button. 

 

 

 

 

• Minimise – when you minimise a program it is still running but is sent to the 

Task Bar. A pale yellow line appears under the program icon in the Task Bar 

to show you a file is open.  

If you hover your mouse over the icon in the Task Bar it will show you a 

picture of any files that are open. 

• Maximise/Restore – if you open a program (e.g. Word) and then open File 

Explorer (the yellow icon on your Task Bar that looks like a Manila folder) it 

will appear in front of the program that is already open – see image below. If 

you’d like to make File Explorer take up the full screen you would click the 

Maximise/Restore button. 

• Close – when you want to close a file you click the X button to close. 

 

 

  

Minimise 

Close 

Maximise/Restore 
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Your USB 

What is a USB? 

A USB is an external storage device. It is where you save documents or files to.  

It is similar to a CD or external hard drive. 

They plug into the side of your computer. 

Some of your USB’s are called “STORE N GO”.  

 

What’s on your USB 

Your student USB contains folders for every unit you will be studying. When you 

open the folder called ‘Cert III BA F2F’ you will see sub-folders with each of the unit 

codes. 

In each units’ folder there is an electronic copy of the Learner Guide and 

Assessment Book for that unit. 

You will be saving all your course work to your USB so make sure you don’t lose it! 

Labelling your USB 

It is a good idea to put a small label on your USB with your name on it (just using 

some masking tape will do). USB’s can get easily lost or left in the classroom printer 

and it is easier to find their owner if you have labelled them. 
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Naming and saving files on your USB 

Think of your computer like a giant filing cabinet. 

You should create folders and save your documents into the appropriate folder, 

just like you would with a paper-based system. This makes finding documents easy.  

For example, you might create a folder called “Bills” and save all your bills in this 

folder.  

1. Naming your assessments 

When you name an assessment activity make sure you use the unit code and the 

activity number. 

For example, if you create a Word document for Activity 12 for the unit BSBITU307 

you should name it: 

BSBITU307-Activity 12 

NB. You can find the unit code on the front page of every assessment book and in 

the top left corner of every page of your assessment book.  

 

2. Saving your assessments 

It’s very important that you save your assessments in the corresponding unit folder 

on your USB. For the above example, you would save the assessment in the folder 

called BSBITU307. 

Your USB already has folders 

created for each unit you are 

studying. 

 

NB. Your computer will default 

to saving documents onto its 

hard drive in the folder called 

‘Documents’. Be careful not to 

let your computer do this as 

this will save the assessment 

to the computer, not your 

USB, making it hard to find the 

document if you use a 

Find the correct folder on your USB e.g. BSBITU307 
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different computer for your next class. 

Practice Exercise 1: Create and save a Word document for the first time 

1. Open a Word document by clicking on the Word icon in the Task Bar. 

2. Type your name in the Word document 

3. Click the ‘File’ menu in the top left corner – refer to image below. 

4. Click ‘Save As’ - refer to image below. (NB. You need to use Save As the first 

time you save a file as this tells your computer where you want to save the 

file to. After you have given the computer a location to save the file the first 

time you can then just click ‘Save’ for all future times you save a document – 

see image on next page). 

5. Click ‘Browse’ - refer to image below and find the folder called ‘USB’ or ‘Store 

n Go’. (Usually located at the bottom of the folders list in File Explorer). Click 

on the folder to select it. 

6. Type the file name ‘Practice Exercise 1” in the box labelled “File Name”. 

7. Click ‘Save’ - refer to image below. 

8. Show your Trainer 

9. Close the file by clicking the X symbol in the top right-hand corner. 

  

Look for folder called USB 

 
Close program 
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Saving after the first time 

Once your file has a file name and location you can just click on the icon that looks 

like an old-fashioned floppy disk at the top of your screen to save any future 

changes. You should get in the habit of saving your changes frequently to ensure no 

work is lost.  
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Finding and opening files 

To open a file you need to locate it first.  

The program you use to find all your files is called “File Explorer”. It is the yellow icon 

on your Task Bar that looks like a manila folder. 

 

 
 

Practise Exercise 2: Find and open a file 

1. Click on File Explorer to open it.  

2. Scroll down the menu on the left side of the page (using the Scroll Bar) till 

you find the folder called ‘USB’ or ‘Store n Go’. Click on it to open it. 

3. Double click on the file you created (Practice Exercise 1) to open it. Or you 

can right click on the file and select ‘Open’ – see screen shots below. 

Scroll bar 

File Explorer 
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Using the search function 

Sometimes we save a file and can’t remember where we saved it.  

If you lose a file don’t panic, you can search for it using the file name, or part of the 

file name. 

Steps: 

1. Open File Explorer 

2. Type the file name (or part of the name) into the ‘Search Quick Access’ bar. 

3. All the files with that name will appear 

 

 

 

  

Search Quick Access bar 
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Finding deleted files 

If you accidently delete a file don’t 

panic. It is not permanently deleted. 

The ‘Recycle Bin’ stores deleted files 

and folders just in case they may be 

needed later. 

To locate a deleted file (or folder) you 

double click on the ‘Recycle Bin’ icon 

(see image) usually found in the top 

left corner of your desktop. This will 

open your recycle bin. 

Type the name of your lost file into the ‘Search Quick access’ tool to find your file. 

Right click on the deleted file (or folder) that you would like to restore.  

Click on ‘Restore’ and the deleted file (or folder) is sent back from where it was 

before it was deleted. 

If you click on ‘Delete’, a warning window appears. If you click ‘Yes’, the file (or folder) 

is permanently deleted and it cannot be restored.  

  Search Quick Access tool 
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Practise Exercise 3: Retrieving a deleted file 

1. Open File Explorer 

2. Find the file you created called ‘Practice Exercise 1’ and delete it by left 

clicking on it once, then hitting the ‘Delete’ key on your keyboard 

3. Double click on the ‘Recycle bin’ icon on your desktop to open it 

4. Find the file you just deleted and right click on it. Click the ‘Restore’ button on 

the menu to retrieve your file.  
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Creating folders 

Sometimes you will need to create a folder. 

For example, you might have a new client you want to create a folder for. 

You create folders in File Explorer. 

Practise Exercise 4: Create a new folder on your USB 

1. Open File Explorer 

2. Find your USB (or Store n Go) in the file directory on the left-hand side. (NB. It 

is often at the bottom of your directory under ‘This PC’). Left click once on the 

folder ‘USB’ so the location is selected. You should be able to see all the sub-

folders already on your USB in the panel on the right. 

3. Move your cursor to the panel on the right and right click in this space. A 

drop-down menu appears. Click on ’New’ and then on ’Folder’. A new ‘New 

Folder’ appears. 

4. Now we want to rename this new folder. To do this you right click on the 

folder icon and a drop-down menu appears. Click ‘Rename’ and type your 

new name into the box; for example ‘Craig Docs’. 

 

  

File Directory 

Sub-folders 
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Moving files or folders  

If you accidently save a file into the wrong folder it is easy to move using cut and 

paste or drag and drop. 

Cut and paste 

To cut and paste you right click on the file you want to move and a drop-down 

menu appears. Click on ’Cut’.  

Then open the folder you want to move it into and right click on ‘Paste’. The file is 

now contained in the new folder. 

Drag and drop 

You left click the file to highlight but this time you hold down the left mouse button. 

Then drag the file to the new folder. Both the file and the folder will be highlighted, 

and a dialog box will appear telling you that the file has been moved. 
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Practise Exercise 5: Move your file to a new location 

In an earlier practice exercise you created a file called ‘Practice Exercise 1’ and a 

folder called your name e.g. Craig Smith. 

You are now going to move the file ‘Practice Exercise 1’ into the folder you created 

with your name using Cut and Paste. 

1. Open File Explorer 

2. Find your file called ‘Practice Exercise 1’. Right click on the file and select ‘Cut’. 

3. Find the folder you created with your name. Right click in this folder and 

select ‘Paste. 

4. Show your trainer. 
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Printing 

Each classroom has a single printer for everyone to share. Please be patient when 

other students are printing. 

The classroom printer is not networked to your computers which means you will 

need to save all your assessments to your USB and take your USB with you to the 

printer. 

Your Learner Guides will give you specific instructions for printing from different 

Microsoft programs, but essentially you will need to follow the below steps for 

printing from your USB: 

1. Plug your USB into the classroom laptop connected to the printer 

2. Open File Explorer 

3. Locate the file you want to print and double click to open the file 

4. Once the file is open, click the ‘File’ menu (in the top left corner) 

5. Click ‘Print’ 

6. Check the print preview and print options. Then click the ‘Print button’.  

7. Close the program  

 

  

File Menu 
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Closing your computer 

Ensure all files have been saved and closed. 

Go to the ‘Windows Start’ button, choose ’Power’ and then ‘Shutdown’. 
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Appendix 

Some basic terminology 

 

Programs  

Programs are a set of instructions that perform certain tasks. They are like apps for 

your phone.  

Some are for writing documents (e.g. Word), others are for processing numbers 

(e.g. Excel), some are for opening emails (e.g. Outlook), or for exploring the internet 

(e.g. Google Chrome, Explorer). 

Programs have icons, or pictures, that you click on to open them (just like your 

phone). You will be using the following programs in this course: 

 

     

Word Excel Google 

Chrome 

Publisher PowerPoint 

Use for 

creating 

letters, 

reports, 

documents 

Use for 

processing 

numbers, 

creating tables 

and graphs, 

e.g. budgets, 

ordering, sales 

figures 

Use for 

exploring the 

internet 

Use for 

creating flyers, 

business 

cards, 

newsletters 

Use for 

creating 

presentations 

 

Windows – operating system 

The computers operating system is the software that controls the operation of your 

computer. It is what tells your computer how to run a program, how to turn on and 

off, how to connect to your mouse and keyboard. It controls your settings for things 

like your screen display, time and language selections, connecting to the internet 

etc.  

Almost all computers use Windows or Mac operating systems. Most office 

computers and your classroom computers use Windows operating systems. 

https://en.wikipedia.org/wiki/Microsoft_Word
https://creativecommons.org/licenses/by-sa/3.0/
https://creativecommons.org/licenses/by-sa/3.0/
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Task Bar 

The task bar is the black ribbon on the bottom of your screen where you can pin 

your most commonly used programs and where the program icon appears when 

you are using a program. See picture on following page. 

If your task bar is hidden, it should automatically show up when you move your 

mouse to the bottom of the screen. 

Menus/tabs 

Each Microsoft program has a list of menus, or tabs, across the top of the page 

(refer to image on the next page). Within each menu is a series of commands that 

are related to that menu’s title. 

For example, in Word the first menu tab is always the Home tab. This contains all 

your basic formatting tools that you use most frequently. 

The next menu is the Insert menu. This contains the tools to insert a table, pictures, 

or a header and footer. 

Microsoft Ribbon 

The ribbon is a set of toolbars at the top of the window in Office programs. See 

picture on following page. 

Sometimes the ribbon can get hidden. To show the ribbon, click on ‘Ribbon Display 

Options’ (top right-hand corner of your screen) and then click ‘Show Tabs and 

Commands’.  

 

 

 

 

 

 

 

 

  

Ribbon Display Options 
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Taking Screenshots 

Taking a screenshot is like taking a photo of your computer screen.  

They are useful for showing someone what is on your screen. For example, you 

might take a screenshot of an error message, or something you found on a web 

page. 

You can take screenshots using the Print Screen function or the Snipping Tool. The 

Print Screen function takes a screen shot (i.e. photo) of your whole screen whereas 

the snipping tool only takes a photo of the area you select. 

Print Screen 

(Takes a screen shot of your whole screen) 

Your keyboard has a ‘Print Screen’ button 

located on the top, right hand side of your 

keyboard. They are sometimes labelled “prt sc”. 

To take a screen shot using Print Screen: 

1. Hold down the Control key and the “Print 

Screen” key at the same time.  

(The screenshot automatically copies to your 

computer clipboard.) 

2. Open the document or email you want to insert 

the screen shot into. 

3. Right click your mouse in the location you want 

the screen shot to appear. Select ‘paste’. 

  

Control key 

Paste 
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Snipping Tool 

(Takes a screen shot of a selected area on your screen) 

To take a screen shot using the Snipping Tool:  

1. Press the Windows key + Shift + S   

 

 

 

 

 

 

 

    

 

 

Your screen will dim to a light grey colour and the Snipping Tool app will appear.  

 

2. Use your mouse (using click and drag) to select the 

area you want to screen shot. Once the area is selected 

it automatically saves to your clipboard. 

3. Open the document or email you want to insert the 

screen shot into. 

4. Right click your mouse in the location you want the 

screen shot to appear. Select ‘paste’.  

  

Windows key 

Paste 

Shift 

S
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Headers and Footers 

A header is a section of the document that appears in the top margin. 

The footer is a section of the document that appears in the bottom margin.  

Headers and footers usually contain additional information such as page numbers, 

dates, file names, and an author's name, which can help keep longer documents 

organized and make them easier to read. 

You can add headers and footers with built-in, ready-made layouts or make your 

own custom headers and footers. 

Inserting a header or footer 

1. Click on the Insert menu. 

2. Click Header or Footer 

3. Select the layout you’d like 

4. Type your text 

5. Click ‘Close Header and Footer’ (or alternately double click in the body of your 

document and the header will close automatically). 

 

 

 

Tip: It’s a good idea to insert a header into all your assessment documents and 

include: 

• Your full name e.g. John Smith 

• The activity number/s e.g. Activity 12 

• The unit number e.g. BSBITU306 

If the document is longer than 1 page you should also insert a footer and include: 

• Page numbers  

This will make it much easier to collate your assessments when you print and attach 

them to your assessment books. 

  

Header or Footer Insert menu 
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Microsoft Updates 

All computers require updates from time to time. This includes your classroom 

computers.  

Microsoft will advise if your computer needs an update and ask you if you’d like to 

allow Microsoft to do the update. It is usually best to let your computer do these 

updates at the very start of class or in your lunch breaks to minimise disruption to 

your work. Most updates are quick to install depending on the speed of your 

internet connection. 

If you are unsure whether to allow an update, please ask your trainer. 

 


